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1 Introduction

1.1 Overview

Weather Message's emPager Pro is a multi-user paging application.  It is designed for
businesses and public services agencies that need a quick and easy way to electronically notify
one or more people individually or in groups.

Groups can be setup with one or more individuals.  A unique feature is conditional group
members.  This capability allows the inclusion of additional members when a predetermined
condition is met.  In emergency dispatch centers, this feature can be used to automatically notify
mutual aid departments.

emPager Pro features a centralized server with easy to use clients.  It supports notifications
using these protocols: SMTP, SNPP, WCTP, TAP, TAP by direct connection, HTTP Post, HTTP
Get and Mototrbo®.

The emPager Pro Client is easy to use and can be installed on one to fifty computers.  It uses
TCP/IP and supports access across the Internet.

In additional to desk-top activation, the software can be configured for activation using specially
crafted emails.

The system features extensive error detection and notifications to insure that messages are
delivered.  It includes detailed reports to view sent messages.

Weather Message – emPager Pro can be downloaded from the Internet and has a 30-day
evaluation period.  You can download it at http://www.wxmesg.com.

Copyright © 2017 Weather Message Software LLC

1.2 Message Delivery Warning

Warning

Due to the nature of telephone based connections and Internet based servers, it is possible that
messages may not be delivered.  emPager Pro has built-in retry mechanisms to make every
attempt to delivery messages.  Even with the internal safeguards, telephone and Internet outages
can prevent delivery of messages.

http://www.wxmesg.com
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1.3 Obtaining Help

Email Support
If you need help with Weather Message, send an email to help@weathermessage.com.

Mail Support
You can reach the program author by mail to Weather Message Software, 203 Old Shepard
Road, Dadeville, Alabama 36853.

Weather Message Website
You can check for software updates and information on the Weather Message Website.

Discussion Group
A Yahoo Discussion Group has also been established for users to exchange ideas and help each
other.  You can join this group at http://groups.yahoo.com/group/WxMesg/join.

1.4 Installation

Weather Message emPager Pro can be purchased on CD or downloaded from the website.  The
CD will automatically load the installation program.  If you download the software from the
Internet, you will need the full installation executable.  It contains all of the files necessary for a
full installation.

Updates to the software can also be downloaded from the Internet.  Same version changes are
free.

emPager Pro can be uninstalled using the standard Windows Add/Remove Programs facility.

emPager Pro features a full 30 day fully functional evaluation.  During the evaluation period, all
aspects of the software function normally.  At the end of the 30 day evaluation, the software will
display an message, asking you to register the software.

Note:  If your installation will use multiple user login names/profiles, we recommend that you
install Weather Message using the administrator login.  This will insure that all users have
access to the programs.

Note:  It is not necessary to uninstall a previous version of emPager Pro before installing an
updated software version.  Uninstalling the software will delete your operating setup
information.

http://www.weathermessage.com
http://groups.yahoo.com/group/WxMesg/join
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2 emPager Pro Server

2.1 Overview

emPager Pro Server is the heart of the paging application.  When started, it appears as a pager
icon in the system tray.

The main window displays the operational status of the program.  As each client connects and
sends pages, those activities are displayed.  The status bar shows the current operation being
performed and/or completed.  It also displays the number of messages pending for delivery by
email and other protocols.

See the following sections to setup Service Providers, Users and Groups.

  Hint:  Service Providers must be established before adding users and groups.

  Note:  emPager Pro Server must be running for the clients to send messages.

Note:  If emPager Pro Server is stopped with the window minimized, the next time it is started,
it will start minimized.

System Tray

When emPager Pro Server is minimized, you can restore the main screen by right clicking on the

system tray icon , then select open.

Copyright © 2017 Weather Message Software LLC
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2.2 Menu Options

The menu buttons on this screen perform these functions:

The File menu allows you to setup this program, maintain service providers, maintain users and
groups, view the paging report, and exit the program.

· The Setup option opens the Setup window.
· The Service Providers option allows you to setup service providers.
· The Users and Groups option allows you to setup users and groups.
· The Remote Access option allows you to setup users for remote access using POP

Retrieval.
· The Import Users option allows you to import users using a CSV formatted file.
· The Paging Report opens the paging report generator window.
· The Exit option stops emPager Server.

The Register menu allows you to register emPager Pro.  This button does not appear if the
software is registered.  Note: If the software is not registered after 30 days, it will stop functioning.

 The Help menu allows you to see this manual, and display information about the program.
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2.3 Setup

The Setup tab is used to define general program operation.

TCP/IP Port designates the TCP/IP port that the clients will use to access the emPager Pro
Server.

The Password, if entered, will cause the server to prompt the user for a password before
allowing changes to Setup, Service Providers, Users and Groups, and stopping the program.

Hint:  Entering a password will prevent the server from being accidentally shutdown.

The Auto Startup option allows you to specify whether emPager Pro Server is automatically
started when Windows starts.  The options are No; Yes, for the current user; and Everyone, for
any user.

Note:  The options available for Auto Startup are based on your user permissions.
Administrator and Power users will have all of the options.  Other users may only have the Yes
option.

Modem Initialization Strings

Modem initialization strings can be different for each modem manufacturer and in most cases are
different.  The following generic strings can be used with most modems.
Generic AT&FQ0V1X4&D2
Generic 14.4 & 28.8 AT&FQ0V1X4&D2N0S37=5
US Robotics AT&F0Q0V1X4&D2&B1&K0&M0&N2

Some US Robotic modems will not communicate with computers at slow baud rates.  If you
encounter problems with your US Robotics modem, use the above initialization string and set the
baud rate for 19200.
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In general your initialization string should do the following.
Send the attention command AT
Load factory defaults &F
Turn echo off E0
Enable result codes Q0
Display result codes as words V1
Enable extended result codes X4 (could be X0)
Enable modem hang up DTR change &D2

In addition, these options should be specified – they vary by manufacturer.
Turn off data compression
Turn off error correction
Turn off flow control

If these codes do not work with your modem, send e-mail to help@wxmesg.com.  Include your
modem model number and we will try to send you an initialization string that will work.

The Pop Retrieval tab is used to define options for the Pop Retrieval service.

The POP Retrieval option is used to activate groups or individuals using specially crafted emails.
To use this option, you will need an email account setup to receive activation requests.

The POP Server field should be the address of your POP server.

Note:  This field should be left blank if you do not want to use POP Retrieval.

The POP Port is the port assigned to your POP server.  This is normally 110.

If your POP Server requires authentication, enter your User Name and Password.

The Method field selects the type of authentication.  Select Password, CRAM, NTLM, Apop,
Plain, Digest MD6, or Kerberos.
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The SSL Required field specifies the type of SSL access, if required.  Select No, Auto, Implict, or
Explicit.

The Polling Interval specifies the amount of time, in seconds, that the program should poll the
POP server.

2.4 Service Providers

The Service Providers window is used to establish and maintain your service providers.  A
Service Provider is the provider used to deliver a message.

Multiple service providers can be setup to support different delivery methods.  For example,
messages that are delivered by email require a SMTP provider.  Messages that are delivered
with the TAP protocol require a TAP provider.  The setup for each service provider describes the
protocol and method used to deliver a message associated with the provider.

  Hint:  Service Providers must be established before adding users and groups.

To edit an existing provider, double click the provider.  For other options, select the provider and
right click to see these menu options.

· The Add option will add a new service provider.
· The Edit option will edit the selected service provider.
· The Delete option will delete the selected service provider.

2.4.1 Provider

The Edit Service Provider window allows you to establish and maintain a service provider.  The
window changes based on the Service Type selected.
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The system supports 6 different protocols; SMTP (email), SNPP, TAP, WCTP, HTTP Post, HTTP
Get, Twitter, Facebook and Mototrbo®.  Set the Service Type field to match the requirements of
your paging or telephone provider.

Service Type: SMTP

The SMTP Server field specifies the SMTP server for delivering email and short messages to cell
telephones.

The E-Mail Address field is the From email address.  It will be shown in emails as the From
Address.

The E-Mail From field can be used to attach your business or agency name and/or abbreviation.
This field will be shown in the e-mail From field.

The SMTP Port defaults to port 25.  If your ISP uses a different port, enter that port number in
this field.

Hint:  SSL (secure) connections use port 465 or 587.

Some ISPs require that you authenticate your connection when you connect to their SMTP
servers.  If your ISP has this requirement, enter your User Name, Password and select the
authentication Method.

Hint:  Use the SMTP authentication fields if they are required, otherwise leave them blank.  If
your ISP does not require authentication and you enter a user name and password, connection
attempts to your email server will fail.

Hint:  The default authentication method is Password.  This setting is used by most servers.
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You can optionally select CRAM or NTLM based on your servers requirements.

If your email server requires a secure connection, set the SSL Required field to Auto, Implicit or
Explicit.  The Auto setting will work for most secure email servers.

Hint:  The Implicit setting starts the connection to the server with a secure channel.  The
Explicit settings starts the connection to the server with an unsecured channel, then uses the
STARTTLS command to switch to a secure channel.  Google's port 465 uses Auto or Implicit.
Google's port 587 uses Explicit.

In the event that an email message cannot be delivered, you can specify the number of times the
software will attempt to deliver the message.  Enter the number of retries in the Failure Retries
field.  Enter the number of minutes between retries in the Retry Minutes field.

Most paging devices have a limitation on the number of characters they can receive in one page.
If your provider has a limit on the size of messages, this limit is should be entered in the Page
Size field.  Entering 0 (zero) will tell the system to not break the message down into packets.

Hint:  Some paging companies restrict the message size that can be sent to their pagers.  If
you exceed the size limitation the page request may be refused or rejected by the paging
company.  If your page requests are being rejected, try a shorter message length.

Service Type: TAP

The Phone Number field specifies the telephone number of the TAP paging terminal.  For direct
connections, leave this field blank.

Select the Baud Rate, Parity/Bits for the selected Comm Port (serial port).
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If the TAP paging terminal requires a password, enter the Password.

Most paging devices have a limitation on the number of characters they can receive in one page.
If your provider has a limit on the size of messages, this limit is should be entered in the
Maximum Page Size field.  Entering 0 (zero) will tell the system to not break the message down
into packets.

Hint:  Some paging companies restrict the message size that can be sent to their pagers.  If
you exceed the size limitation the page request may be refused or rejected by the paging
company.  If your page requests are being rejected, try a shorter message length.

Note:  Due to message size limitations for the TAP protocol, you will be required to enter a
maximum page size between 1 and 240 characters.

In the event that a page cannot be delivered, you can specify the number of times the software
will attempt to deliver the message.  Enter the number of retries in the Failure Retries field.
Enter the number of minutes between retries in the Retry Minutes field.

Note: For the TAP protocol, the Failure Retries field is used to specify the number of times that
the program will attempt to connect to your paging provider when their modem line number is
busy.

The Tx Delay ms field specifies the amount of time, in milliseconds, to pause between
consecutive pages.  Some paging terminals, like Visiplex, require a six second delay between
messages.

Service Type: SNPP, WCTP, HTTP Post, HTTP Get
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The Server field specifies the server address for delivering messages.

The Port defaults to port 444 for SNPP and port 80 for HTTP.  Enter the port required for your
provider.

Most paging devices have a limitation on the number of characters they can receive in one page.
If your provider has a limit on the size of messages, this limit is should be entered in the
Maximum Page Size field.  Entering 0 (zero) will tell the system to not break the message down
into packets.

Hint:  Some paging companies restrict the message size that can be sent to their pagers.  If
you exceed the size limitation the page request may be refused or rejected by the paging
company.  If your page requests are being rejected, try a shorter message length.

In the event that a page cannot be delivered, you can specify the number of times the software
will attempt to deliver the message.  Enter the number of retries in the Failure Retries field.
Enter the number of minutes between retries in the Retry Minutes field.

The HTTP Post and HTTP Get option allows you to interface directly with a web page or web
server.  The Post option posts variables to the web server.  The Get option URL encodes the
variables before appending them to the http address. These options require a good
understanding of posting data to web servers and the paging providers webpage.  It is beyond
the scope of this manual to describe these requirements.  If you have questions contact Weather
Message Support.

For HTTP, you must enter the information and variables to be posted or URL encoded to the
HTTP server.  Enter the required information in the HTTP Post Variables field.  They are entered
in the format variable=value.  Three replacement variables are available to insert the pager pin,
group name and message.  Use the variable $Pin$ to insert the pager pin, $Group$ to insert the
paging group name, and $Message$ to insert the pager message.

The following is an example of the variables needed for the SouthernLinc HTTP server.

PageArea1=
PageNum1=$Pin$
From=EMWIN
PageMsg=$Message$
NumChars=
Page=Send Message

Service Type: Twitter
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Click the Authorize button to launch a window to authorize Twitter.

Service Type: Mototrbo
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The Interface Address field specifies the ip address for the Mototrbo® interface.

The Port should be set to the Mototrbo® texting port.  The default is 4007.

2.5 Users and Groups

emPager Pro uses the concept of Users and Groups.  Users define the individuals that will
receive a page.  Users can be associated with different Service Providers.

Groups are composed of individual Users.  These users are called members.  This allows you to
associate members with different groups that will receive messages.  Users can be members of
multiple groups.

Groups can have regular members and conditional members.  Regular members will always
receive a message.  Conditional members receive messages when a pre-determined condition is
met.  The emPager Pro Client's quick buttons can be configured to trigger the conditional
members.

A good example of conditional members is the concept of automatic aid used for fire
departments.  For routine calls, only the regular members receive messages.  However, when a
structure fire is reported, the regular and conditional members need to receive the call.

  Hint:  Service Providers must be established before adding users and groups.



Weather Message - emPager Pro Server18

© 2017 Weather Message Software LLC

2.5.1 Users Tab

The Users Tab is used to establish and maintain your users.

To edit an existing user, double click the user.  For other options, select the user and right click to
see these menu options.

· The Add option will add a new user.
· The Edit option will edit the selected user.
· The Delete option will delete the selected user.

2.5.1.1 User

The Edit User window allows you to establish and maintain a user.
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Enter the User Name.  The User Name will be displayed in the emPager Pro Client.

Optionally enter a Call Sign for the user.  The emPager Pro Client can optionally display this call
sign in the list of users.

Optionally enter a Message Prefix.  The Message Prefix is prepended to the sent message.

Select a Service Provider from the drop down list.  See the Service Providers section for more
information on establishing service providers.

Enter the email address or pin for this user.  For email users, click on the @ button to see a list
of Phone Provider Formats.

The Visible check box determines whether this user is displayed in the emPager Pro Client user
list.  When users are associated with a group, it may not be desirable to see the user in emPager
Pro Client.  Regardless of this setting the user can be associated with one or more groups.

The Remote Access field allows you to enable this entry for remote access.  The dropdown
shows a list of remote access users.  Leave this field blank to disable remote access.

Note:  If you associate a remote access user with multiple users, each user will be activated
when the remote access user sends a message.

For Mototrbo® providers, you can specify the CAI (Common Air Interface) number assigned to
the radio network.  The Request ACK allows to you specify where an acknowledgement should
be requested for each sent message.

The Notes text box allows you to enter any miscellaneous notes about this user.
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2.5.1.2 Phone Provider Formats

The Phone Provider Formats window displays the email format for messaging by email.  This
format is used to enter the user's associated telephone number and address.

If this list does not contain your Phone Provider, contact Weather Message for assistance.

2.5.2 Groups Tab

The Groups Tab is used to establish and maintain groups.

To edit an existing group, double click the group.  For other options, select the group and right
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click to see these menu options.

· The Add option will add a new group.
· The Edit option will edit the selected group.
· The Delete option will delete the selected group.

  Hint:  Users must be established before adding groups.

2.5.2.1 Group

The Edit Group window allows you to establish and maintain a group.

Enter a name for the group.  The Group Name will be displayed in the emPager Pro Client.

The Members tab contains the regular members.  Regular members will always receive the
message.  To select members click on one or more available users and click the < button.  To
remove members, select one or more members and click the > button.
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The Conditional Members tab contains the conditional members.  Conditional members will
receive a message when a predefined condition is met.  To select members click on one or more
available users and click the < button.  To remove members, select one or more members and
click the > button.

2.6 Remote Access

The Remote Access window is used to establish and maintain your remote access users.  A
remote access user can send specially crafted email message to send a message to associated
users.

Multiple remote access users can be setup to for activation.  When a properly crafted email is
received, the system will activate each group associated with the remote access user.

To edit an existing remote user, double click the provider.  For other options, select the provider
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and right click to see these menu options.

Activating by Email

To activate a user or group send an email to the configured email address.  Enter the access
code followed by a "/" then the password in the subject line.  In the body of the message enter
the text to be sent.

2.6.1 Remote Access Entry

The Remote Access window allows you to establish and maintain remote access.

Enter a Description for this remote access user.  Enter their Access Code and Password.

2.7 Paging Report

The Paging Report window allows you to run a report of pages sent.

Enter a Beginning and Ending Date for the report.  You can optionally select one user to report.
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Click the View button to view the report.

The following is an example report generated by the system.

The report displays the entry date, user name, service type, status and message sent.  The
Status field contains these codes:  S for successful, R for retry needed, and F for failed.

Use the buttons at the top of the window to navigate to different pages.  These buttons also allow
you to print the report or export it in CSV or PDF format.

2.8 Register Software

The Register menu option allows you to register your software.

When you purchase emPager Pro, you will be supplied with a Registration Name and
Registration Code.  Enter these exactly as they are printed.  These fields are case sensitive.

After the software is registered, we recommend that you stop and restart the software.

To purchase the software go to http://www.wxmesg.com/purchpay.htm.

http://www.wxmesg.com/purchpay.htm
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3 emPager Pro Client

3.1 Overview

emPager Pro Client is used to send messages to individuals and/or groups.  The Client can be
installed on each computer that needs that ability to quickly send messages.

When emPager Pro Client is first started, it connects to the emPager Pro Server.  The Server
sends a list of available Users and Groups.  These appear in the Users/Groups list box.  Groups
are indicated with the two people icon.  Individuals are indicated with the single person icon.

Hint:  Before emPager Pro Client can connect to the emPager Pro Server, you must enter the
Server Address.

Hint:  If a red LED appears in the status bar, the program is not communicating with the
emPager Pro Server.   emPager Pro Server must be running for the clients to send messages.

The Status tab is used to view the status of messages.  It also shows acknowledgements from
Mototrbo® radios.

For detailed instructions on sending messages, see the Sending a Message section.

Copyright © 2017 Weather Message Software LLC
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3.2 Menu Options

The menu buttons on this screen perform these functions:

The File menu allows you to setup program options and exit the program.

· The Setup option opens the Setup window.
· The Exit option stops emPager Client.

The Options menu allows you to select specific user preferences.  To show the Call Signs
associated with each individual, click the Show Call Sign option.

 The Help menu allows you to see this manual, and display information about the program.

Quick Buttons appear below the File menu option.  The Client supports up to 5 different Quick
Buttons.  These buttons can be setup with different routine messages to reduce the amount of
typing.  The Quick Buttons can also be programmed to activate conditional group members.
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3.3 Sending a Message

Sending Messages

Step 1
To send a message, select one or more Users and/or Groups.  Multiple selections can be
made by holding down the control key and clicking multiple entries.  When a User or Group is
selected, the name is highlighted.

Step 2
If needed, click a Quick Button.  Quick Buttons can be used to quickly insert common
messages.  Quick Buttons can also be programmed to activate conditional members.  See
Quick Buttons for more information.

Hint:  When the Quick Button is used, the user can change the message.
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Hint:  If the Activate Conditional Members option is checked for a Quick Button, a red
message will be displayed informing the user that conditional members will be activated.

Step 3
Enter a message to send.  The number of characters typed will appear below the Message
box.

Step 4
Click the Send Page button to send the message.  The status bar will display the message
"Page sent for processing ... ".  When the message is sent by emPager Pro Server, the status
bar will display the message "Page Sent".

Hint:  If a red LED appears in the status bar, the program is not communicating with the
emPager Pro Server.   emPager Pro Server must be running for the clients to send messages.

Hint:  Once a message has been sent, the selected Users/Groups and Message can be
cleared by clicking the Clear button.  This can occur automatically by changing the
Reset on Send option in Setup.

Status Messages

If the system cannot deliver the message to the provider associated with the user or group, a
message will be displayed.  This alerts the user to a possible Internet connectivity or paging
terminal error.  To see status message click the Status tab.

Mototrbo® radios can send responses.  These responses are displayed on this tab.
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3.4 Setup

3.4.1 Server Tab

The Server Tab is used to define general program operation.

The Server Address is the address of the emPager Pro Server.  Enter the address of your
server in this field.

Note:  When this field is left blank, the client will try to discover the address and port of the
emPager Server.  If your server is on the same local network as the client, it will automatically
obtain the address and port.  If the client is running on a different network, you will need to
enter the address and port of the server.

The TCP/IP Port is the port defined in emPager Pro Server for connections.  The default is
25001.

The Password, if entered, will cause the Client to prompt the user for a password before
allowing changes in Setup.

The Reset on Send option, when checked, will cause the system to automatically reset the
selected User/Groups and Message when Send Page is clicked.

The Auto Startup option allows you to specify whether emPager Pro Client is automatically
started when Windows starts.  The options are No; Yes, for the current user; and Everyone, for
any user.

Note:  The options available for Auto Startup are based on your user permissions.
Administrator and Power users will have all of the options.  Other users may only have the Yes
option.
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3.4.2 Quick Buttons Tab

The Quick Button Tab is used to define Quick Buttons.

Quick Buttons are used to enter predefined messages.  These can be as simple as "Call the
office." or more complex depending on your requirements.  When a button is defined, it appears
in the tool bar below the File menu option.

For each button, you can define the text that appears for the button, the message that will be
automatically entered, and whether the button activates conditional members of groups.

To add, change or delete a button, click the button.  The Edit Quick Button window will be
displayed.

3.4.2.1 Quick Button

The Edit Quick Button window is used to add, change, or delete a quick button.
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In the Button Text field, enter the text that will be displayed in the tool bar.  This should be a
short message.  Long text will take up the room available for quick buttons.

In the Message field, enter the text that you want automatically entered in the message box.

Hint:  When the Quick Button is used to send a message, the user will have the ability to
change the message.

The Activate Conditional Members check box, when checked, will cause the system to send
messages to any conditional members associated with a selected group.

Note:  This option has no effect on selected individuals.

A good example of conditional members is the concept of automatic aid used for fire
departments.  For routine calls, only the regular members receive messages.  However, when a
structure fire is reported, the regular and conditional members need to receive the call.  In this
case a Quick Button could be programmed with the words Structure Fire and the Activate
Conditional Members option checked.
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4 Supplement

4.1 Sending Tweets using Twitter

emPager supports sending tweets to TwitterTM.  This ability is possible by using the http post
option in the Service Providers setup.

To setup emPager for Twitter, you need to setup a Twitter service provider and a Twitter user.
The following procedure outlines these steps.

Create a Twitter Service Provider

Open emPager Server, Click File, then Service Providers.  Right click in the grid and click Add,
the Service Provider window will appear.  Fill out the screen as shown below.

Click the Authorize button to authorize Twitter.

After entering the above information, click Save.  Click Save again to save the service providers.

Create a Twitter User

Click File, then Users and Groups.  On the Users Tab, right click in the grid and click Add, the
User window will appear.  Fill out the screen as shown below.

http://twitter.com
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Enter a User Name for the Twitter User.

Set the Service Provider to the Twitter Service.

The Address/Pin needs one Pin number to operate properly, we suggest 1234.  The Pin is not
used by Twitter.

After entering the above information, click Save.  Click Save again to save the user.

You can now send tweets using this Twitter user.  This user can also be associated with any
group.
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5 Software License

LICENSE AGREEMENT

I. LICENSE GRANT.
Danny Lloyd, hereafter referred to as Author, grants you a non-exclusive license to use the
software known as emPager, or emPager Pro, hereafter referred to as Software.

II. DISCLAIMER OF WARRANTY.
Software is provided on an "AS IS" basis, without warranty of any kind, including without
limitation the warranties of merchantability, fitness for a particular purpose and non-
infringement. The entire risk as to the quality and performance of the Software is borne by you.
Should the Software prove defective, you and not Author assume the entire cost of any service
and repair. In addition, the security mechanisms implemented by Author software have
inherent limitations, and you must determine that the Software sufficiently meets your
requirements. This disclaimer of warranty constitutes an essential part of the agreement.
SOME JURISDICTIONS DO NOT ALLOW EXCLUSIONS OF AN IMPLIED WARRANTY, SO
THIS DISCLAIMER MAY NOT APPLY TO YOU AND YOU MAY HAVE OTHER LEGAL
RIGHTS THAT VARY BY JURISDICTION.

III. SCOPE OF GRANT.
You may:
· use the emPager Pro Server on one computer;
· use the emPager Pro Client  on any number of computers, up to the capacity of emPager

Pro Server.
· copy the Software for archival purposes, provided any copy must contain all of the original

Software's proprietary notices.
  You may not:
· permit other individuals to use the Software except under the terms listed above;
· modify, translate, reverse engineer, decompile, disassemble (except to the extent applicable

laws specifically prohibit such restriction), or create derivative works based on the Software;
· rent, lease, grant a security interest in, or otherwise transfer rights to the Software; or
· remove any proprietary notices or labels on the Software.

IV. TITLE.
Title, ownership rights, and intellectual property rights in the Software shall remain in Author.
The Software is protected by copyright laws. Title and related rights in the content accessed
through the Software is the property of the applicable content owner and may be protected by
applicable law. This License gives you no rights to such content.

V. TERMINATION.
The license will terminate automatically if you fail to comply with the limitations described
herein. On termination, you must destroy all copies of the Software.

VI. LIMITATION OF LIABILITY.
UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, TORT, CONTRACT, OR
OTHERWISE, SHALL AUTHOR OR ITS SUPPLIERS OR RESELLERS BE LIABLE TO YOU
OR ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT LIMITATION,
DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR
MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL DAMAGES OR LOSSES. IN NO
EVENT WILL AUTHOR BE LIABLE FOR ANY DAMAGES IN EXCESS OF THE AMOUNT
AUTHOR RECEIVED FROM YOU FOR A LICENSE TO THE SOFTWARE, EVEN IF AUTHOR
SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY
CLAIM BY ANY OTHER PARTY. THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO
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LIABILITY FOR DEATH OR PERSONAL INJURY TO THE EXTENT APPLICABLE LAW
PROHIBITS SUCH LIMITATION. FURTHERMORE, SOME JURISDICTIONS DO NOT
ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL
DAMAGES, SO THIS LIMITATION AND EXCLUSION MAY NOT APPLY TO YOU.

VII. HIGH RISK ACTIVITIES.
The Software is not fault-tolerant and is not designed, manufactured or intended for use or
resale in computer systems, in which the failure of the Software could lead directly to death, or
personal injury. Author specifically disclaim any express or implied warranty of fitness for High
Risk Activities.

VIII. MISCELLANEOUS.
This Agreement represents the complete agreement concerning this license and may
amended only by a writing executed by both parties. If any provision of this Agreement is held
to be unenforceable, such provision shall be reformed only to the extent necessary to make it
enforceable. This Agreement shall be governed by the laws of the state of Alabama.
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